Contents

1 INTRODUCTION ................................................................................................................................. 6
   System Description ............................................................................................................................. 6
   How to Use This Manual ..................................................................................................................... 6
       Conventions .................................................................................................................................. 7
   Certification ...................................................................................................................................... 8
   Unpacking and Inspection .................................................................................................................. 8
       Serial Number ............................................................................................................................... 8
   To Our Customers ............................................................................................................................... 9
   What We Provide ............................................................................................................................... 10
       Warranty Provisions ...................................................................................................................... 10
   How to Contact Us ............................................................................................................................. 10
       To Obtain Repair Service (U.S.) ................................................................................................. 10
       Guidelines for Cleaning Returned Equipment .......................................................................... 12

2 SYSTEM COMPONENTS ..................................................................................................................... 14
   Body ................................................................................................................................................. 14
   Cable ................................................................................................................................................. 14
       Communication Cables .................................................................................................................. 18
   Power Components ........................................................................................................................... 19
   Installation Accessories ...................................................................................................................... 20
   Control Software ............................................................................................................................... 21
   Product Specifications ....................................................................................................................... 22
## 3 GETTING STARTED

A. Connect the RuggedCable or Programming Cable to the Level TROLL ........................................... 26
B. Connect the TROLL Com to the RuggedCable .............................................................................. 29
C. Connect to the Host PC .................................................................................................................. 30
D. Install the Software ......................................................................................................................... 31
E. Launch the Software ......................................................................................................................... 31

## 4 USING WIN-SITU

Connect to the Level TROLL ................................................................................................................... 32
The Home Screen ...................................................................................................................................... 34
Customizing the Home Screen Display ................................................................................................... 35
Setting the Clock ...................................................................................................................................... 36
Adding a New Site ..................................................................................................................................... 37
Preparing to Log Data ............................................................................................................................... 41
Disconnecting .......................................................................................................................................... 43

## 5 ABOUT THE PRESSURE/ LEVEL SENSOR

Non-Vented (Absolute) vs. Vented (Gauged) Sensors ............................................................................ 44
Pressure, Depth, and Level .......................................................................................................................... 45
Configuring Depth and Level ...................................................................................................................... 46
Pressure Sensor Calibration ....................................................................................................................... 49
  Factory Recalibration .............................................................................................................................. 49
  Field Recalibration ................................................................................................................................. 49
  Barometric Compensation of Non-Vented Pressure/Level Data using BaroMerge™ ...................... 51

## 6 FIELD INSTALLATION

Position the Level TROLL .......................................................................................................................... 53
Secure the Cable ........................................................................................................................................... 54
Installation Tips .............................................................................................................................................. 54
Stabilization Time ......................................................................................................................................... 55
Installation of a Level TROLL 300 or Other Non-Vented Level TROLL .................................................... 56
## CONTENTS

### 7 BAROTROLL
- Programming ................................................................. 57
- Installation ........................................................................ 57

### 8 ANALOG, SDI-12 & MODBUS CONNECTIONS
- Desiccant ........................................................................... 61
- Wiring .................................................................................. 61
- Power Connections ............................................................ 66
- Communications ............................................................... 66
- Using Win-Situ ..................................................................... 66
- For More Information ......................................................... 67

### 9 CARE & MAINTENANCE
- Operating Considerations .................................................. 68
- Storage .................................................................................. 69
- General Maintenance .......................................................... 69
  - Cleaning—Body and Front End .......................................... 69
  - Twist-Lock Connectors ...................................................... 70
  - Cable Vent Tube (Vented Cable) ....................................... 70
- Batteries ............................................................................... 70

### 10 TROUBLESHOOTING .......................................................... 71

### INDEX ................................................................................ 74

### DECLARATIONS OF CONFORMITY ........................................ 76
1  INTRODUCTION

SYSTEM DESCRIPTION

Your new Level TROLL is a compact, modular system for measuring level and temperature in natural groundwater and surface water, as well as industrial, waste, and other installations. Components include the instrument body, vented and non-vented cables, communication cables, external power accessories, desiccants and other installation accessories, and software.

HOW TO USE THIS MANUAL

This operator’s manual is designed as both a start-up guide and a permanent reference for the Level TROLL’s features and applications.

Section 1: Introduction to the Level TROLL Operator’s Manual and to In-Situ Inc. — Warranty Provisions — Instrument Repair & Return Recommendations
Section 2: Components and features of the Level TROLL system — Accessories — Product Specifications

Section 3: Getting Started — Attaching Cable — Installing & Launching the Software

Section 4: Using Win-Situ — Connecting for the First Time — Setting the Clock — Setting a Device Site — Preparing to Log Data — Disconnecting

Section 5: About the Pressure (Level) Sensor: The two basic types of pressure sensors — Factory and field calibration

Section 6: Field Installation — Guidelines and Precautions for Long-Term Deployment of the Level TROLL

Section 7: The BaroTROLL

Section 8: Connecting for use with SDI-12, Analog (4-20 mA), and Modbus loggers and controllers

Section 9: Care & Maintenance

Section 10: Troubleshooting

CONVENTIONS
Throughout this operator’s manual you will see the following symbols.

The check mark highlights a tip about a convenient feature of the Level TROLL

The exclamation point calls your attention to a requirement or important action that should not be overlooked
CERTIFICATION
The Level TROLL complies with all applicable directives required by CE and the FCC and found to comply with EN 61326, ICES-003, and FCC Part 15 specifications. Declarations of conformity may be found at end of this manual.

UNPACKING AND INSPECTION
Your Level TROLL was carefully inspected before shipping. Check for any physical damage sustained during shipment. Notify In-Situ and file a claim with the carriers involved if there is any such damage; do not attempt to operate the instrument. Accessories may be shipped separately and should also be inspected for physical damage and the fulfillment of your order.

SERIAL NUMBER
The serial number is engraved on the body of the Level TROLL. It is also programmed into the instrument and displayed when the instrument is connected to a computer running Win-Situ 5 or Win-Situ Mobile. We recommend that owners keep a separate record of this number. Should your Level TROLL be lost or stolen, the serial number is often necessary for tracing and recovery, as well as any insurance claims. If necessary, In-Situ maintains complete records of original owner’s names and serial numbers.
TO OUR CUSTOMERS . . .

Thank you for your purchase of an In-Situ product. We are glad you chose us and our products to help you with your environmental monitoring needs. In-Situ Inc. has been designing and manufacturing world-class environmental monitoring instrumentation for over 25 years in the Rocky Mountains of the United States. As it was in the beginning, our expectation is that this product will provide you with many trouble-free years of use. To that end, we pride ourselves on delivering the best customer service and support possible—24 hours a day, 7 days a week. We believe that this level of commitment to you, our customer, is imperative in helping you ensure clean, safe groundwater and surface water resources across the globe. We also understand the need for accurate, reliable assessments and we continue to make significant investments in Research and Development to ensure that we deliver the latest product and technological innovations to support your needs.

Whether you are gathering information about your body of water for a few moments, or over a period of years, you can rely upon us to provide you with a quality product and outstanding customer support at a fair price and have that product delivered to you when and where you need it.

We want your experience with In-Situ Inc. to be pleasant and professional, whether you are renting from us, or purchasing from us. We would be pleased to hear from you and learn more about your needs, and your experiences with our products. Again, we thank you for choosing In-Situ Inc. and we look forward to serving your needs now, and in the future.

Bob Blythe, President and CEO
In-Situ Inc.
bblythe@in-situ.com
WHAT WE PROVIDE

WARRANTY PROVISIONS
In-Situ Inc. warrants the Level TROLL and Baro TROLL for one year from date of purchase by the end user against defects in materials and workmanship under normal operating conditions. To exercise this warranty contact Technical Support at the phone or e-mail address listed below for a return material authorization (RMA) and instructions. Complete warranty provisions are posted on our website at www.In-Situ.com.

FIRMWARE & SOFTWARE UPGRADES
The Level TROLL is upgradeable. Contact In-Situ Inc. for details.

HOW TO CONTACT US
Technical Support: 800 446 7488
Toll-free 24 hours a day in the U.S. and Canada
Address: In-Situ Inc.
221 East Lincoln Ave.
Fort Collins, CO 80524
USA
Phone: 970 498 1500
Fax: 970 498 1598
Internet: www.in-situ.com
e-mail: support@in-situ.com

TO OBTAIN REPAIR SERVICE (U.S.)
If you suspect that your Level TROLL is malfunctioning and repair is required, you can help assure efficient servicing by following these guidelines:

1. Call or e-mail In-Situ Technical Support (support@in-situ.com). Have the product model and serial number handy.
2. Be prepared to describe the problem, including how the instrument was being used and the conditions noted at the time of the malfunction.

3. If Tech Support determines that service is needed, they will ask that your company pre-approve a specified dollar amount for repair charges. When the pre-approval is received, Tech Support will assign an RMA (Return Material Authorization) number.

4. Clean the Level TROLL and cable. Decontaminate thoroughly if it has been used in a toxic or hazardous environment. See the Cleaning Guidelines and form on page 13.

5. Carefully pack your Level TROLL in its original shipping box, if possible. Include a statement certifying that the instrument and cable have been decontaminated, and any supporting information.

6. Mark the RMA number clearly on the outside of the box with a marker or label.

7. Send the package, shipping prepaid, to
   In-Situ Inc.
   ATTN: Repairs
   221 E. Lincoln Ave.
   Fort Collins, CO 80524

   The warranty does not cover damage during transit. We recommend the customer insure all shipments. Warranty repairs will be shipped back prepaid.

**Outside the U.S.**

Contact your international In-Situ distributor for repair and service information.
**GUIDELINES FOR CLEANING RETURNED EQUIPMENT**

Please help us protect the health and safety of our employees by cleaning and decontaminating equipment that has been subjected to any potential biological or health hazards, and labeling such equipment. Unfortunately, we cannot service your equipment without such notification. Please complete and sign the form on page 13 (or a similar statement certifying that the equipment has been cleaned and decontaminated) and send it along to us with each downhole instrument.

- We recommend a good cleaning solution, such as Alconox®, a glassware cleaning product available from In-Situ (Catalog No. 0029810) and laboratory supply houses.
- Clean all cabling. Remove all foreign matter.
- Clean cable connector(s) with a clean, dry cloth. Do not submerge.
- Clean the probe body—including the nose cone, cable head, and protective caps. Remove all foreign matter.

If an instrument is returned to our Service Center for repair or recalibration without a statement that it has been cleaned and decontaminated, or in the opinion of our Service Representatives presents a potential health or biological hazard, we reserve the right to withhold service until proper certification has been obtained.

**If an instrument returned for servicing shows evidence of having been deployed in a toxic or hazardous environment, Customer Service personnel will require written proof of decontamination before they can service the unit.**

**TIP:** Alconox® is available from In-Situ Inc. (Catalog No. 29810).
## Decontamination & Cleaning Statement

Company Name: ___________________________ Phone: ___________________________

Address: ________________________________

City: ___________________ State: ___________ Zip: ____________________

Instrument Type: __________________________ Serial Number: __________________

Contaminant(s) (if known): ________________________________

Decontamination procedure(s) used: ________________________________

Cleaning verified by: ___________________________ Title: _______________________

Date: ________________________________
2  SYSTEM COMPONENTS

BODY
The completely sealed Level TROLL contains pressure and temperature sensors, real-time clock, microprocessor, sealed lithium battery, data logger, and memory. Options include a vented or non-vented pressure sensor in a variety of ranges.

TIP: There are no user-serviceable parts in the Level TROLL body.

CABLE
Several basic cable types are used in the Level TROLL system.

- RuggedCable™, TPU-jacketed (Thermoplastic PolyUrethane)
  - vented or non-vented
  - Halogen-Free vented or non-vented (LSZH-rated, low smoke zero halide)
- Vented FEP* cable
- Stainless steel suspension wire for deployment of a non-vented instrument
- Communication cables for programming the device/downloading the logged data

* FEP (fluorinated ethylene propylene) is the generic equivalent of DuPont Teflon®
**RuggedCable™**

Cable includes conductors for power and communication signals, a strength member, and a Kellems® grip to anchor the Level TROLL securely. Available in standard and custom lengths.

Uphole and downhole ends are identical “female” bayonet-type Twist-Lock connectors that mate with the Level TROLL body, TROLL Com communication cable, desiccants, and other accessories. Available in rugged all-titanium or standard carbon-filled ABS plastic.

Vented cable is designed for use with vented pressure/level sensors (gauged measurements). The cable vent tube insures that atmospheric pressure is the reference pressure applied to the sensor diaphragm. Vented cable includes a small desiccant cap.

Non-vented cable may be used with non-vented pressure/level sensors (absolute measurements).
**RuggedCable “Stripped & Tinned”**  
In place of the “uphole” Twist-Lock connector, this cable ends in bare conductors for wiring to a logger or controller using SDI-12, analog (4-20 mA), or Modbus communication protocols. Vented cable includes an outboard desiccant to protect against condensation.

Also available in a shorter length ending in a “male” Twist-Lock connector to mate with RuggedCable.

For connections, refer to wiring diagrams in Section 7.

**Suspension Wire**
FEP-coated stainless steel suspension cable is ideal for deployment of instruments with non-vented pressure sensors: Level TROLL 300, non-vented Level TROLL 500 or 700, and BaroTROLL.
Small Desiccant

Vented cable includes a clear cap of indicating silica gel desiccant to protect the cable and electronics from condensation. The desiccant is blue when active. It will absorb moisture from the top down and for best results should be replaced before the entire volume has lost its color. Replacements are available from In-Situ Inc. or your distributor.

Large Desiccant

The optional high-volume desiccant pack may last up to 20 times longer than the small desiccant in humid environments. It attaches to vented Level TROLL cable in the same way. Refill kits are also available from In-Situ Inc. or your distributor.

Outboard Desiccant

Vented “stripped & tinned” cable includes an outboard desiccant pack attached to the cable vent tube. Same size as large desiccant. Replacements and refills are available.

Accessory

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small desiccant (3)</td>
<td>0052230</td>
</tr>
<tr>
<td>Large desiccant</td>
<td>0051810</td>
</tr>
<tr>
<td>Outboard desiccant (replacement)</td>
<td>0051380</td>
</tr>
<tr>
<td>Refill kit for large &amp; outboard desiccant</td>
<td>0029140</td>
</tr>
</tbody>
</table>
COMMUNICATION CABLES
Comm cables provide an interface between the Level TROLL and a desktop/laptop PC or handheld PDA for profiling, calibrating, programming, and downloading.

TROLL Com (RS232)
Vented polyurethane cable (0.9 m, 3 ft), connects the Level TROLL's RuggedCable to a PC's serial port. Converts the Level TROLL's RS485 signal to RS232 for communication via the serial port on a host computer. Weatherproof, withstands a temporary immersion. Cable vents into unit, protected by a hydrophobic membrane.

Programming Cable (RS232)
Vented polyurethane or halogen-free polyurethane cable (1.8 m, 6 ft) combines the functions of the RuggedCable and TROLL Com; connects the Level TROLL directly to a serial port; includes RS485/RS232 converter and external power input jack. A good choice for permanent connection to a PC, or where external power is desirable, or for programming a non-vented Level TROLL that will be deployed without RuggedCable.

Accessory Catalog No.
TROLL Com, RS232 ................................................................. 0051460
Programming cable ........................................................................ 0051840
Programming cable, halogen-free .................................................. 0051850
USB to serial adapter .................................................................... 0031090

The computer connectors are not submersible.
POWER COMPONENTS

INTERNAL POWER
The Level TROLL operates on 3.6 VDC, supplied by a completely sealed, non-replaceable AA lithium battery. Battery life depends on sampling speed. The battery is guaranteed for 5 years or 2,000,000 readings, whichever occurs first.

EXTERNAL POWER

External Battery Pack
The sealed, submersible TROLL Battery Pack (lithium) supplies 14.4 V. When this power source is connected, the Level TROLL will use the external battery source first and switch to the internal batteries when external battery power is depleted. Battery life depends on sampling speed.

<table>
<thead>
<tr>
<th>Sampling Interval</th>
<th>Battery Life</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 sec</td>
<td>1.2 months</td>
</tr>
<tr>
<td>1 sec</td>
<td>2.3 months</td>
</tr>
<tr>
<td>1 min or longer</td>
<td>1 year</td>
</tr>
</tbody>
</table>

AC Adapter
In-Situ’s AC adapter provides 24 VDC, 0.75 A, AC input 100-250 V, includes North American power cord. The Programming Cable includes an external power input for connection to this adapter.

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Battery Pack</td>
<td>0051450</td>
</tr>
<tr>
<td>AC Adapter 24V</td>
<td>0052440</td>
</tr>
</tbody>
</table>
INSTALLATION ACCESSORIES

- 1/4” NPT Adapter: allows Level TROLL installation in piping
- Twist-Lock Hanger: titanium or stainless steel hanger to suspend a non-vented Level TROLL or BaroTROLL while taking data; no venting, no communication capabilities
- Cable Extender: connects two lengths of RuggedCable
- Wellcaps, locking and vented
- Well Docks: top-of-well support for 2”, 4”, or 6” well
- Panel-mounted bulkhead for connection to RuggedCable

Accessory | Catalog No.
--- | ---
NPT Adapter | 0051470
Twist-Lock Hanger, titanium for Level TROLL 500, 700, Baro | 0051480
Twist-Lock Hanger, stainless steel for Level TROLL 300 | 0055050
Cable Extender | 0051490
Locking Wellcap, 2” | 0020360
Locking Wellcap, 2” vented | 0020370
Locking Wellcap, 4” | 0020380
Locking Wellcap, 4” vented | 0020390
Top-of-well installation ring | WELLDOCK2”, 4”, 6”
Bulkhead connector | 0053240
Weighted nose cone | 0057570
CONTROL SOFTWARE

Win-Situ® 5 is easy-to-use software for programming the Level TROLL.

Win-Situ provides instrument control for direct reads and profiling, long-term data logging, data downloads, data viewing, data export to popular spreadsheet programs, choice of units and other display options, battery/memory usage tracking, interface to networks and telemetry.

Minimum system requirements: 400 MHz Pentium® II processor, 128 Mb RAM, 100 Mb free disk space, Internet Explorer® 6.01 or higher, Windows® 2000 Professional SP4 or higher, or Windows XP Professional SP2 or higher, or Windows Vista SP1 or higher, CD-ROM drive, and a serial communications port.

Complete information on using the software is available from Win-Situ’s Help menu.

Win-Situ® Mobile (formerly Pocket-Situ 5) provides Win-Situ’s features and functions on a field-portable platform. Requirements: In-Situ RuggedReader® with Microsoft Windows Mobile® operating system (yellow RuggedReader, Pocket PC 2003 or later; blue RuggedReader, Windows Mobile 5 or later), serial communications port, and at least 16 Mb for data storage (SD card, CF card, or the device’s built-in non-volatile memory). For installation and file exchange, Microsoft® ActiveSync® must be installed on an office desktop or laptop computer.

Accessory  
Win-Situ 5 (no license required) ................................................... 0051980  
Win-Situ Mobile license for RuggedReader ................................. 0047520  
Win-Situ Mobile license (upgrade from Pocket-Situ 4) ................. 0047550
## PRODUCT SPECIFICATIONS

<table>
<thead>
<tr>
<th></th>
<th>Level TROLL 300</th>
<th>Level TROLL 500</th>
<th>Level TROLL 700</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating Temperature</strong></td>
<td>0 to 50°C (32 to 122°F)</td>
<td>-20 to 80°C (-4 to 176°F)</td>
<td>-20 to 80°C (-4 to 176°F)</td>
</tr>
<tr>
<td><strong>Storage Temperature</strong></td>
<td>-40 to 80°C (-40 to 176°F)</td>
<td>-40 to 80°C (-40 to 176°F)</td>
<td>-40 to 80°C (-40 to 176°F)</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O.D.</td>
<td>20.82 mm (0.82 in)</td>
<td>18.3 mm (0.72 in)</td>
<td>18.3 mm (0.72 in)</td>
</tr>
<tr>
<td>Length</td>
<td>22.9 cm (9.0 in)</td>
<td>21.6 cm (8.5 in)</td>
<td>21.6 cm (8.5 in)</td>
</tr>
<tr>
<td>Weight</td>
<td>0.24 kg (0.54 lb)</td>
<td>0.197 kg (0.43 lb)</td>
<td>0.197 kg (0.43 lb)</td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Housing</td>
<td>316L Stainless steel</td>
<td>Titanium</td>
<td>Titanium</td>
</tr>
<tr>
<td>Nose Cone</td>
<td>Black Delrin®</td>
<td>Black Delrin®</td>
<td>Black Delrin®</td>
</tr>
<tr>
<td><strong>Output Options</strong></td>
<td>RS232 (with TROLL Com), Modbus (RS485), SDI-12, 4-20mA</td>
<td>RS232 (with TROLL Com), Modbus (RS485), SDI-12, 4-20mA</td>
<td>RS232 (with TROLL Com), Modbus (RS485), SDI-12, 4-20mA</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internal Battery</td>
<td>3.6V lithium</td>
<td>3.6V lithium</td>
<td>3.6V lithium</td>
</tr>
<tr>
<td>Battery Life</td>
<td>5 yrs or 2M readings*</td>
<td>5 yrs or 2M readings*</td>
<td>5 yrs or 2M readings*</td>
</tr>
<tr>
<td>External Power</td>
<td>8-36 VDC</td>
<td>8-36 VDC</td>
<td>8-36 VDC</td>
</tr>
<tr>
<td>External Battery</td>
<td>14.4 V lithium</td>
<td>14.4 V lithium</td>
<td>14.4 V lithium</td>
</tr>
<tr>
<td>Real-Time Reading Rate</td>
<td>1 per second</td>
<td>1 per second</td>
<td>1 per second</td>
</tr>
<tr>
<td>Memory/Data Points**</td>
<td>1 MB / 50,000</td>
<td>2 MB / 100,000</td>
<td>4 MB / 350,000</td>
</tr>
<tr>
<td>Fastest Logging Rate</td>
<td>1 per second</td>
<td>2 per second</td>
<td>4 per second</td>
</tr>
<tr>
<td>Max. no. of logs</td>
<td>2</td>
<td>2</td>
<td>50</td>
</tr>
<tr>
<td>Log Types</td>
<td>Linear, Fast Linear</td>
<td>Linear, Fast Linear</td>
<td>Linear, Fast Linear, Linear Average, Step Linear, Event, True Logarithmic</td>
</tr>
</tbody>
</table>

* 1 reading = time plus all available parameters read from device or logged
** 1 data point = time plus one parameter in a data log
### Pressure/Level Sensor

<table>
<thead>
<tr>
<th></th>
<th>Level TROLL 300</th>
<th>Level TROLL 500</th>
<th>Level TROLL 700</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Silicon strain gauge</td>
<td>Silicon strain gauge</td>
<td>Silicon strain gauge</td>
</tr>
<tr>
<td>Material</td>
<td>Stainless steel</td>
<td>Titanium</td>
<td>Titanium</td>
</tr>
<tr>
<td>Accuracy*</td>
<td>@ 15°C: ± 0.2% FS</td>
<td>± 0.05% FS</td>
<td>± 0.05% FS</td>
</tr>
<tr>
<td></td>
<td>-5 to +50°C: ± 0.2% FS</td>
<td>± 0.1% FS</td>
<td>± 0.1% FS</td>
</tr>
<tr>
<td></td>
<td>-20 to -5 &amp; +50 to +80°C: NA</td>
<td>± 0.25% FS typical</td>
<td>± 0.25% FS typical</td>
</tr>
<tr>
<td>Resolution</td>
<td>± 0.01% FS or better</td>
<td>± 0.005% FS or better</td>
<td>± 0.005% FS or better</td>
</tr>
<tr>
<td>Range</td>
<td>Non-Vented (PSIA)</td>
<td>30, 100, 300</td>
<td>30, 100, 300, 500</td>
</tr>
<tr>
<td></td>
<td>Vented (PSIG)</td>
<td>—</td>
<td>5, 15, 30, 100, 300, 500</td>
</tr>
<tr>
<td>Max. pressure</td>
<td>2X range</td>
<td>2X range</td>
<td>2X range</td>
</tr>
<tr>
<td>Burst pressure</td>
<td>3X range</td>
<td>3X range</td>
<td>3X range</td>
</tr>
</tbody>
</table>

### Temperature Sensor

<table>
<thead>
<tr>
<th></th>
<th>Level TROLL 300</th>
<th>Level TROLL 500</th>
<th>Level TROLL 700</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Silicon</td>
<td>Silicon</td>
<td>Silicon</td>
</tr>
<tr>
<td>Accuracy</td>
<td>± 0.25°C</td>
<td>± 0.1°C</td>
<td>± 0.1°C</td>
</tr>
<tr>
<td>Resolution</td>
<td>0.1°C</td>
<td>0.01°C</td>
<td>0.01°C</td>
</tr>
</tbody>
</table>

* FS = full scale. Accuracy with 4-20 mA output option: ± 0.25% FS typical

### Range and Usable Depth

#### Non-Vented Level TROLL

<table>
<thead>
<tr>
<th>Range</th>
<th>Effective Range**</th>
<th>Usable Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSIA</td>
<td>PSIA kPa</td>
<td>Meters</td>
</tr>
<tr>
<td>30</td>
<td>15.5</td>
<td>106.9</td>
</tr>
<tr>
<td>100</td>
<td>85.5</td>
<td>589.5</td>
</tr>
<tr>
<td>300</td>
<td>285.5</td>
<td>1968</td>
</tr>
<tr>
<td>500</td>
<td>485.5</td>
<td>3347</td>
</tr>
</tbody>
</table>

**At sea level (14.5 PSI atmospheric pressure).

#### Vented Level TROLL

<table>
<thead>
<tr>
<th>Range</th>
<th>Usable Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSIG</td>
<td>kPa</td>
</tr>
<tr>
<td>5</td>
<td>34.5</td>
</tr>
<tr>
<td>15</td>
<td>103.4</td>
</tr>
<tr>
<td>30</td>
<td>206.8</td>
</tr>
<tr>
<td>100</td>
<td>689.5</td>
</tr>
<tr>
<td>300</td>
<td>2068</td>
</tr>
<tr>
<td>500</td>
<td>3447</td>
</tr>
</tbody>
</table>

**At sea level (14.5 PSI atmospheric pressure).

### BaroTROLL

Same as Level TROLL 500 specs, except Pressure Range: 0 to 16.5 PSIA (1.14 bar, 33.59 in Hg), Log Types: Linear, Fastest Logging Rate: 1 per minute
### Cable

<table>
<thead>
<tr>
<th>Description</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jacket options</td>
<td>Polyurethane, halogen-free (HF) polyurethane, FEP*</td>
</tr>
<tr>
<td>Connector</td>
<td>Titanium or carbon-filled ABS plastic, 18.5 mm (0.73 in) O.D.</td>
</tr>
<tr>
<td>Conductors</td>
<td>6 conductors, 24 AWG, polypropylene insulation</td>
</tr>
<tr>
<td>Diameter</td>
<td>6.7 mm (0.265 in)</td>
</tr>
<tr>
<td>Break strength</td>
<td>127 kg (280 lb)</td>
</tr>
<tr>
<td>Minimum bend radius (vented cable)</td>
<td>2X cable diameter (13.5 mm, 0.54 in)</td>
</tr>
<tr>
<td>Weight</td>
<td>Vented, regular &amp; HF: 14 kg/300 m (32.3 lb/1000 ft)</td>
</tr>
<tr>
<td></td>
<td>Non-vented, regular &amp; HF: 16 kg/300 m (35.6 lb/1000 ft)</td>
</tr>
<tr>
<td></td>
<td>Vented FEP: 23 kg/300 m (52 lb/1000 ft)</td>
</tr>
</tbody>
</table>

### Suspension Wire

<table>
<thead>
<tr>
<th>Description</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>304 stainless steel, 7 x 7 strand</td>
</tr>
<tr>
<td>Coating</td>
<td>Recycled FEP*, 0.5 mm (0.020 in) thick</td>
</tr>
<tr>
<td>Weight</td>
<td>4.3 kg /300 m (9.75 lb/1000 ft)</td>
</tr>
<tr>
<td>Overall O.D.</td>
<td>2.2 mm (approx. 1/16 in)</td>
</tr>
<tr>
<td>Break strength</td>
<td>122 kg (270 lb)</td>
</tr>
</tbody>
</table>

*FEP = fluorinated ethylene propylene, the generic equivalent of DuPont Teflon®*
3 GETTING STARTED

This section provides a quick overview of the initial steps necessary to get the instrument ready to log data.

You will need—

- Level TROLL or BaroTROLL
- Cable
  - RuggedCable and TROLL Com communication cable (for devices that will be deployed on RuggedCable), or
  - Programming Cable (for devices that will be deployed on suspension wire)
- In-Situ Software/Resource CD
- Desktop / laptop PC
- Optional: RuggedReader® handheld PDA
- Software License Certificate for licensed software (Win-Situ Mobile)
A. CONNECT THE RUGGED CABLE OR PROGRAMMING CABLE TO THE LEVEL TROLL

1. Remove the protective caps from the Level TROLL and cable.

   ![Level TROLL (or TROLL Com) Cable](image)

   **TIP:** Retain the dust caps to protect the pins and o-ring from damage when cable is not attached.

2. Take a moment to look at the connectors. Each has a flat side.

   ![Flat Flat](image)

   ![Flat](image)

   Note the pins on the body connector (one on each side) and the slots on the cable connector (one on each side).
3. Slide back the sleeve on the cable connector.

4. Orient the “flats” so they will mate up, and insert the Level TROLL connector firmly into the cable connector.

5. Slide the sleeve on the cable toward the Level TROLL body until the pin on the body pops into the round hole in the slot on the cable connector.
6. Grasp the knurled (textured) section of the cable connector in one hand and the Level TROLL body in the other. Push and twist firmly so that the pin on the body connector slides along the slot on the cable connector and locks securely into the other hole.

Be sure you hear the “click.” The “click” ensures the cable is securely attached.

If you connected RuggedCable, continue to step B. If you connected a Programming Cable, skip to step C.
B. CONNECT THE TROLL COM TO THE RUGGEDCABLE

1. Remove the desiccant from the free end of the RuggedCable (if present) by grasping the knurled (textured) section of the cable connector in one hand and the desiccant in the other. Twist in opposite directions to unlock the desiccant from the cable.

2. Slide back the sleeve on the cable connector. Locate the “flats” on the cable connector and the TROLL Com connector as before.

3. Orient the “flats” so they will mate up, and insert the TROLL Com connector firmly into the cable connector.

4. Slide the metal sleeve on the cable toward the TROLL Com body until the pin on the body pops into the hole in the slot on the cable connector.

5. Grasp the knurled (textured) section of the cable connector in one hand and the TROLL Com body in the other. Push and twist firmly so that the pin on the body slides along the slot on the cable connector and snaps securely into the other hole.

Be sure you hear the “click.” The “click” ensures the cable is securely attached.
C. CONNECT TO THE HOST PC

Attach the TROLL Com or Programming Cable to a PC.

RS232 connections

- Serial port
- PC
- PDA
- Programming Cable
- TROLL Com
- RuggedCable
- Level TROLL or BaroTROLL
D. INSTALL THE SOFTWARE

Install Win-Situ 5 from the In-Situ software/resource CD or from the In-Situ website:

1. Click on Win-Situ 5 and follow the instructions to install Win-Situ 5 to your local hard drive.

For communication using a RuggedReader handheld in the field, install the desktop component of Win-Situ Mobile (formerly called Pocket-Situ 5) on the same desktop/laptop computer:

1. Click on Win-Situ Mobile and follow the instructions to install the Win-Situ Software Manager to your local hard drive.

2. Connect the RuggedReader to the desktop computer, establish a connection in Microsoft ActiveSync®, launch the Win-Situ Software Manager, and follow the instructions to install Win-Situ Mobile on the RuggedReader.

E. LAUNCH THE SOFTWARE

Start Win-Situ by double-clicking the shortcut created on the desktop during installation.

The next section of this manual provides a brief overview of Win-Situ. For more detailed information, see Win-Situ’s Help menu.
4 USING WIN-SITU

Win-Situ® 5 is In-Situ’s instrument control software for Level TROLLs. Use Win-Situ to

- display real-time readings from the connected Level TROLL, in meter, tabular, or graphic format
- program the device to log data; download the logged data
- customize the output of a pressure/level sensor to record draw-down, surface water elevation, gauge height, stage height, etc.
- set communication options in the device—Modbus, SDI-12, analog, IP, telemetry, etc.

CONNECT TO THE LEVEL TROLL

1. Start Win-Situ by double-clicking the shortcut created on the desktop during installation.
Win-Situ launches and displays the Data area ("tab").

2. Check the COM port (optional). When you launch for the first time, the software may ask if you want to select a COM port. Do one of the following:
   - Answer Yes to the prompt, then check or change the port in the Comm Settings dialog, and click OK to close it, or
   - Answer No to bypass this step.

3. Win-Situ asks if you want to connect to the Level TROLL (the "device"). If the Level TROLL is connected to your computer as described in the previous section, answer Yes.
4. Software connects and displays a reading of all supported parameters.

THE HOME SCREEN

- Note the Tabs at the top of the screen— this is the Home tab, which displays current readings from the connected device.

- The Dashboard (status area) shows the device model and serial number, battery and memory usage, clock alarms, and logging status.

- The Control Panel contains action buttons. To update the readings in real time press [click here to update readings in real time].

  Note: When this button looks “pressed in” [device is connected], polling is active.

  Before you can perform certain software tasks, you will need to stop polling by pressing the button again.
CUSTOMIZING THE HOME SCREEN DISPLAY

Changing Units
1. Click the Sensors tab, select the level/pressure sensor.
2. Click the Configure button in the control panel.
3. In the Sensor Setup screen, select a parameter, then select a unit. Repeat for each parameter as necessary.
4. Click OK to change the units and return to the Sensors tab.

Changing the Rate at Which the Readings Update
Also called the “poll rate,” this can range from 1 to 30 seconds.
1. Select Preferences menu > Home View Settings.
2. Adjust the Poll Rate. Default: 5 seconds.

Changing the Decimal Places Displayed
To change the number of decimal places displayed for each reading:
1. Select Preferences menu > General Settings.
2. Under Parameter Defaults, select a parameter, then the “significant digits” for each parameter.

Real-Time Graphing
To view a real-time trend graph: click the graph button
To view a graph with a data table below it, select Preferences menu > Graph Settings. Check the Data Panel option. Click OK.
Now you’re ready to give the Level TROLL some specific information through the software. Win-Situ provides many options. At a minimum:

- set the Level TROLL clock
- enter a name for the site where the Level TROLL will collect data
- enter data logging instructions

A brief overview is provided here. For more detailed information, see Win-Situ’s Help menu.

**SETTING THE CLOCK**

Data collection schedules depend on the device’s real-time clock. Both the device clock and the system (PC) clock are shown on the dashboard. The clocks update every 2 seconds. If the device clock differs by more than 2 seconds from the system clock, the device clock is displayed in red. To synchronize the clocks, click the Sync button.
**ADDING A NEW SITE**

Logged data are organized and filed by the **site** where the data were logged. This feature can help you manage data from multiple sites. You can create as many sites as you like, with or without a Level TROLL connected. Sites are stored in the site database in your Win-Situ working directory and are available to select for any Level TROLL, any log.

You will need a site when setting up a data log. Here are the steps to set up a new site:

1. On the Data tab, click the Site Data folder.
2. Select File menu > New > Site.
3. In the Site Information screen, enter a name for the site. A short, descriptive name is best—for example, a project, well, water body, gauging station, town, nearby landmark, etc. Length is limited to 32 characters.

TIP: The site coordinates are optional. They are used to uniquely identify a data site. They are not used elsewhere by the software.

A site name the only required field, but there are many additional options for identifying a site. To include site Coordinates, check Coordinates, then enter Latitude (0.00 to 90.00, select North or South from listbox), Longitude (0.00 to 180.00, select East or West) and Elevation (select Feet or Meters). You can add a short descriptive Note, import a site Photo (bitmap), and/or specify a custom Connection. (If any connections have been defined, they will be displayed.)

4. When finished, click **Save** to save the site.
The new site will appear in the Site Data folder, and Win-Situ will add it to the site database in the working directory on your computer. It is now available to select for any device, any log.
5. To set this new site in the connected Level TROLL: Return to the Home tab, click the down arrow beside the site box, and select your new site.

This site now becomes the “current” site for the connected Level TROLL, and is available to use in data logs.
PREPARING TO LOG DATA

1. To program the device to log data, first select the Logging tab.

2. Click the “New” button.

The Logging Setup Wizard will prompt you through the configuration of a data log—including the site, log name, parameters to measure, sample schedule, start time, stop time, output (depth or level), and other options. For details on setting the pressure sensor output, refer to Win-Situ’s Help menu, or Section 5 in this manual.

TIP: For more complete information on setting up data logs, see Win-Situ’s Help menu.

TIP: For a Level TROLL 300 or other non-vented Level TROLL that will be deployed on wire, be sure to select a Scheduled Start so the log will start by itself, without a communication connection.
To Start logging:
- A “Pending” (scheduled) log will start at its programmed time
- You can start a “Ready” (manual) log at any time while connected by selecting the log and pressing “Start”.

To Stop logging:
- Select the log and press the “Stop” button.
- Or suspend (temporarily stop) it with the “Pause” button.

To Download the log to the connected PC:
- Select the log and press the “Download” button.

To View the log after downloading:
- Go to the Data tab and select the log; for a graph press.

**TIP:** As an alternative to the log control buttons, right-click a log to display a short context menu of available actions.

**TIP:** The available log control buttons will vary depending on the status of the log selected.
**DISCONNECTING**

After the Level TROLL is programmed to log data, you're ready to

- Exit the software (File menu > Exit).

- Disconnect the TROLL Com from the cable connector, by grasping the knurled (textured) section of the cable connector in one hand and the TROLL Com in the other. Twist in opposite directions to unlock the TROLL Com from the cable.

- Vented cable: Attach desiccant to the cable connector—line up the flat sides of the connectors, push, twist, and click to lock the desiccant to the cable. Remove red dust cap (if present) from the desiccant’s vent.

- Non-vented Level TROLL or BaroTROLL: Attach a Twist-Lock hanger to prevent flooding, and suspension wire (if using).

- Install the instrument in its field location. See Section 6 for guidelines.
5 ABOUT THE PRESSURE/LEVEL SENSOR

A pressure transducer senses changes in pressure, measured in force per square unit of surface area, exerted by water or other fluid on an internal media-isolated strain gauge. Common measurement units are pounds per square inch (PSI) or newtons per square meter (pascals).

NON-VENTED (ABSOLUTE) VS. VENTED (GAUGED) SENSORS

A non-vented or “absolute” pressure sensor measures all pressure forces exerted on the strain gauge, including atmospheric pressure. Its units are PSIA (pounds per square inch “absolute”), measured with respect to zero pressure.

Non-vented pressure measurements are useful in vacuum testing, in short-term testing when atmospheric pressure would not be expected to change, in very deep aquifers where the effects of atmospheric pressure are negligible, and in unconfined aquifers that are open to the atmosphere.
With vented or “gauged” pressure sensors, a vent tube in the cable applies atmospheric pressure to the back of the strain gauge. The basic unit for vented measurements is **PSIG** (pounds per square inch “gauge”), measured with respect to atmospheric pressure. Vented sensors thus exclude the atmospheric or barometric pressure component.

This difference between absolute and gauged measurements may be represented by a simple equation:

\[
P_{\text{gauge}} = P_{\text{absolute}} - P_{\text{atmosphere}}
\]

**PRESSURE, DEPTH, AND LEVEL**

Output options for pressure measurement are completely software-selectable. Each log configuration presents the following choices:

- Pressure in PSI or kPa
- Depth in feet or meters
- Water Level with a reference (an “offset”)
  - Surface Elevation reference
  - Depth to Water (drawdown) reference

Pressure is a simple check box. For depth or level, the software presents additional options:

- The type of Level measurement you wish to log
- The Level Reference you wish to use
- The type of water you will be monitoring in (fresh, brackish, or saline). Or choose the **Advanced** button for a pressure-to-level conversion that compensates pressure readings for fluid density, latitude, and elevation.

**TIP:** For more on the differences between Absolute (non-vented) and Gauged (vented) sensors, see the technical note on the In-Situ software/resource CD, or the Downloads section of the In-Situ website at www.In-Situ.com.
CONFIGURING DEPTH AND LEVEL

This procedure stores the configuration settings in the Level TROLL. When setting up a log, the same options are presented.

1. While connected to the Level TROLL in software, click the Sensors tab.

2. Select the level/pressure sensor and click the “Configure” button. (Not available for a BaroTROLL.)
3. In the Sensor Setup window, select the Level parameter, then click **Configure**...

The Level parameter shown is the one currently stored in the device (device’s default or the most recent choice). You will have a chance to change this in a moment.
4. In the Level Setup Wizard, select the options you want. Each choice includes an illustration. For more information, see Win-Situ’s On-Line Help.
PRESSURE SENSOR CALIBRATION

FACTORY RECALIBRATION

Pressure sensor accuracy can be adversely affected by improper care and handling, lightning strikes and similar surges, exceeding operating temperature and pressure limits, physical damage or abuse, as well as normal drift in the device’s electronic components. Aside from damage to the sensor, the need for factory recalibration is dependent upon the amount of drift a customer is willing to tolerate. Factory calibration every 12-18 months is recommended. Contact In-Situ Customer Service for information on the factory maintenance and calibration plan.

FIELD RECALIBRATION

The following procedure may be used, with caution, to “zero” the offset of a vented pressure sensor to correct for electronic drift. The drifted offset is visible when the sensor is in air and reading other than zero.

It is recommended you do not zero the offset if it is outside the specified accuracy of your pressure sensor, as shown in the table below. If the reading in air deviates from zero by more than the amounts shown, you may want to consider a factory recalibration.

<table>
<thead>
<tr>
<th>Sensor range</th>
<th>Accuracy (-5°C to +50°C)</th>
<th>Acceptable Offset from zero</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 PSI</td>
<td>± 0.1% FS</td>
<td>± 0.005 PSI</td>
</tr>
<tr>
<td>15 PSI</td>
<td>± 0.1% FS</td>
<td>± 0.015 PSI</td>
</tr>
<tr>
<td>30 PSI</td>
<td>± 0.1% FS</td>
<td>± 0.03 PSI</td>
</tr>
<tr>
<td>100 PSI</td>
<td>± 0.1% FS</td>
<td>± 0.10 PSI</td>
</tr>
<tr>
<td>300 PSI</td>
<td>± 0.1% FS</td>
<td>± 0.30 PSI</td>
</tr>
<tr>
<td>500 PSI</td>
<td>± 0.1% FS</td>
<td>± 0.50 PSI</td>
</tr>
</tbody>
</table>

TIP: Field recalibration is not available for a BaroTROLL.
Field Recalibration Procedure

1. With the Level TROLL connected in software, select the Sensors tab.

2. Select the pressure sensor and click the Calibrate button.
   
   You will be prompted to ensure the device is in air.

3. With the device in air, click Calibrate.

The current pressure reading will be set to zero.
BAROMETRIC COMPENSATION OF NON-VENTED PRESSURE/LEVEL DATA USING BAROMERGE™

Win-Situ BaroMerge can post-correct absolute (non-vented) level sensor data to eliminate barometric pressure from the measurements. BaroMerge provides 3 options:

• Fixed Correction – A single offset value is applied to all selected log data. Use this option if you know what the barometric pressure was during the log, and it did not change

• Manual Entry – Specify 2 or more correction values to apply to the log data. Use this option if you know that barometric pressure changed during the log

• BaroTROLL log file – Absolute level sensor data are corrected by barometric pressure values logged by an In-Situ BaroTROLL during the same general time period

Launching BaroMerge

BaroMerge may be launched as a stand-alone application from the program group In-Situ Inc., or accessed from Win-Situ’s Tools menu when both are installed on the same system.

Input

In the Fixed Correction and Manual Entry options, it is important to know the barometric pressure for the general time period covered by the log or logs you want to correct.

BaroMerge uses a Wizard-like interface consisting of three main steps:

1. First, choose the type of compensation/correction you wish to use
2. Then, choose the absolute (non-vented) log file or files you wish to correct. BaroMerge displays these automatically.

3. Click OK and the barometric compensation is applied.

**Output**

Your original log file is not changed. A new, corrected log file with the same name and path is created. The original “.wsl” extension is replaced by “-BaroMerge.wsl”.

For help on using Win-Situ BaroMerge, press F1 at any BaroMerge screen.

For more detailed information on barometric compensation see the technical notes on the In-Situ software/resource CD, or the Downloads section of the In-Situ website at www.In-Situ.com.
6 FIELD INSTALLATION

POSITION THE LEVEL TROLL

Lower the Level TROLL gently to approximately the desired depth. Position the instrument below the lowest anticipated water level, but not so low that its range might be exceeded at the highest anticipated level. Refer to the tables below for usable depth.

Note that a Baro TROLL is not designed for submersion. Position it above water level near a submerged Level TROLL.

<table>
<thead>
<tr>
<th>Range</th>
<th>Usable Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSIG</td>
<td>kPa Meters</td>
</tr>
<tr>
<td>5</td>
<td>34.5 0-3.5</td>
</tr>
<tr>
<td>15</td>
<td>103.4 0-11</td>
</tr>
<tr>
<td>30</td>
<td>206.8 0-21</td>
</tr>
<tr>
<td>100</td>
<td>689.5 0-70</td>
</tr>
<tr>
<td>300</td>
<td>2068 0-210</td>
</tr>
<tr>
<td>500</td>
<td>3447 0-351</td>
</tr>
</tbody>
</table>

Vented Level TROLL

Non-Vented Level TROLL

<table>
<thead>
<tr>
<th>Range</th>
<th>Effective Range*</th>
<th>Usable Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSIA</td>
<td>PSIA kPa Meters</td>
<td>Feet</td>
</tr>
<tr>
<td>30</td>
<td>15.5 106.9</td>
<td>0-10.9 0-35.8</td>
</tr>
<tr>
<td>100</td>
<td>85.5 589.5</td>
<td>0-60.1 0-197.3</td>
</tr>
<tr>
<td>300</td>
<td>285.5 1968</td>
<td>0-200.7 0-658.7</td>
</tr>
<tr>
<td>500</td>
<td>485.5 3347</td>
<td>0-341.3 0-1120</td>
</tr>
</tbody>
</table>

*At sea level (14.5 PSI atmospheric pressure).
CHECK THE INSTRUMENT’S DEPTH

At this point, if convenient, you can connect the Level TROLL to a PC, launch the software, and take a reading. If the instrument is at the desired depth, secure it in position as suggested below. If not, reposition the Level TROLL as necessary.

If you requested the software to “Remind me later” to set a Level Reference, enter the level reference after installation when prompted.

SECURE THE CABLE

The RuggedCable has a handy device called a Kellems® grip near the surface end. You can slide it along the cable to the desired position by compressing it. When you pull on it, it tightens and stops sliding. You may need to pull on both ends of the Kellems grip to properly tighten it and keep it from slipping.

Use the loop of the Kellems grip to anchor the cable to a convenient stationary object. It works well with In-Situ’s “well dock” installation ring. Simply insert the loop into the locking clip on the well dock, and position the assembly on the top of a well.

INSTALLATION TIPS

- Never let a probe “free fall” down a well. The resulting shock wave when it hits the water surface can damage the strain gauge (the “waterhammer” effect).

- It is always wise to check the level of water above the probe, then move it and read again to be sure that the probe is giving a reasonable reading and showing change. It might not be
located where you think it is — for example, it could be wedged against the casing with a loop of cable hanging below it. A probe in such a position might become dislodged and move while logging, giving a false change in level. *A secure placement is critical to accurate measurements.*

- Do not allow the vented cable to kink or bend. If the internal vent tube is obstructed, water level measurements can be adversely affected. The recommended minimum bend radius is 13.5 mm (0.54 in), which is twice the cable diameter.

- For accurate measurements, the instrument should remain immobile while logging data.

- Be sure the “uphole” cable end is capped—desiccant cap on the vented cable connector, soft dust cap on non-vented cable—and positioned above the highest anticipated water level. Avoid areas that may flood.

**STABILIZATION TIME**

Allow the Level TROLL to stabilize to the water conditions for *about an hour* before logging data. A generous stabilization time is always desirable, especially in long-term deployments. Even though the cable is shielded, temperature stabilization, stretching, and unkinking can cause apparent changes in the probe reading. If you expect to monitor water levels to the accuracy of the probe, it’s worth allowing the extra time for the probe to stabilize to its environment.
INSTALLATION OF A LEVEL TROLL 300 OR OTHER NON-VENTED LEVEL TROLL

All Level TROLL 300s and non-vented Level TROLL 500s and 700s include non-vented (absolute, PSIA) pressure sensors and do not require vented cable for proper operation. They may be deployed on non-vented RuggedCable or with a Twist-Lock Hanger and economical stainless steel suspension wire while logging data.

- Because the Twist-Lock Hanger has no communication capabilities, program the Level TROLL in advance, and download the data the same way.
- Logged pressure data will show the effects of changes in barometric pressure (unlike vented Level TROLLs). However, post-processing tools such as Win-Situ BaroMerge may be used to eliminate the effects of barometric pressure changes from the data, if required.

TIP: Be sure to program a non-vented Level TROLL or BaroTROLL before attaching the Twist-Lock Hanger, as this accessory has no communication capability.

DO NOT submerge a non-vented Level TROLL 500 or 700 without first attaching a Twist-Lock Hanger, or a cable, as the unit could be damaged by flooding.

Although the Level TROLL 300 is completely sealed from flooding, a Hanger is recommended.
In-Situ’s BaroTROLL® is a special model of non-vented Level TROLL designed to log barometric pressure from 0 to 16.5 PSIA (1.14 bar, 33.59 in Hg) at the surface near a submerged non-vented Level TROLL. BaroTROLL data may then be used to correct the Level TROLL data for barometric pressure fluctuations.

**PROGRAMMING**

- Program before installation. Be sure to sync the clock.
- Schedule a log with the same start time as that in the paired non-vented Level TROLL. Select the same sample interval.

**INSTALLATION**

After programming, install the BaroTROLL in a protected location above water level. Install the BaroTROLL near the submerged non-vented unit. One possibility is shown below, using a Twist-Lock Hanger and suspension wire.

- Be sure to attach the Twist-Lock Hanger before installation to prevent flooding.

**TIP:** For more detailed information on barometric compensation see the technical notes on the In-Situ software/resource CD, or the Downloads section of the In-Situ website at www.InSitu.com.
Section 7: BaroTroll

Pressure due to atmosphere (measured by BaroTROLL)

Pressure due to water column (measured by non-vented sensor)

Pressure due to atmosphere + water column (measured by vented sensor, or by subtracting BaroTROLL data from non-vented sensor data)
The Level TROLL may be connected to a controller or logger for communication via:

- Analog (4-20 mA)
- SDI-12
- RS485 Modbus
- RS232 Modbus (with a customer-supplied converter)

RuggedCable™ Stripped & Tinned has a “female” Twist-Lock connector on one end to mate with the Level TROLL body. The uphole end terminates in bare wires for connection to a PLC or data logger.

Also available in a shorter length ending in a “male” Twist-Lock connector to mate with RuggedCable.
Stripped & Tinned Cable with “female” connector

Short Stripped & Tinned Cable with “male” connector

Rugged Cable

PLC or Logger

Level TROLL
DESIICCANT

Vented cable includes removable outboard desiccant to protect the cable vent tube and Level TROLL electronics from condensation in high-humidity environments.

The desiccant may be removed from the vent tube, if needed, to trim the conductor wires. Pull the vent tube extender off the cable vent tube to remove, replace desiccant after trimming and connecting wires.

WIRING

Refer to diagrams on the following pages. Trim back and insulate unused wires. The shield should be wired to a chassis ground or earth ground.

<table>
<thead>
<tr>
<th>Signal</th>
<th>Color</th>
<th>Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gnd/Return</td>
<td>BLACK</td>
<td>6</td>
</tr>
<tr>
<td>Ext Power</td>
<td>RED</td>
<td>5</td>
</tr>
<tr>
<td>4-20 mA</td>
<td>BROWN</td>
<td>4</td>
</tr>
<tr>
<td>RS485(−)</td>
<td>GREEN</td>
<td>3</td>
</tr>
<tr>
<td>RS485(+)</td>
<td>BLUE</td>
<td>2</td>
</tr>
<tr>
<td>SDI-12</td>
<td>WHITE</td>
<td>1</td>
</tr>
</tbody>
</table>

Rugged Cable (TPU)

<table>
<thead>
<tr>
<th>Signal</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gnd/Return</td>
<td>BLACK</td>
</tr>
<tr>
<td>Ext Power</td>
<td>RED</td>
</tr>
<tr>
<td>4-20 mA</td>
<td>BROWN</td>
</tr>
<tr>
<td>RS485(−)</td>
<td>GREEN</td>
</tr>
<tr>
<td>RS485(+)</td>
<td>ORANGE</td>
</tr>
<tr>
<td>SDI-12</td>
<td>YELLOW</td>
</tr>
</tbody>
</table>

FEP Cable
SECTION 8: ANALOG, SDI-12, MODBUS

ANALOG (4-20 mA) 2 WIRE

PLC or Data Logger

+ 12-36 VDC

SIGNAL

GND/RETURN BLACK

4-20 mA BROWN

Level TROLL
SDI-12 3 WIRE

Data Logger

9.6-16 VDC

SDI-12 WHITE*

EXT PWR RED

GND/RETURN BLACK

RS485 (-) GREEN

RS485 (+) BLUE**

* Yellow for FEP cable
** Orange for FEP cable

Max. cable length 200 ft

SDI-12 sensor
MODBUS MASTER
with RS485 built in

Digital PLC
12-36 VDC*

EXT PWR RED

GND/RETURN BLACK

RS485 (–) GREEN

RS485 (+) BLUE**

* Optional but highly recommended
** Orange for FEP cable
**MODBUS MASTER**
with RS232 built in (converter required)

Digital PLC

12 VDC*

** CONverter **
Port-Powered RS485 converter, such as B&B Electronics Model 485SD9TB

* Voltage limited by converter
** Orange for FEP cable

***Required if port power is not available
POWER CONNECTIONS
The Red wire provides power for Modbus and SDI-12 modes. The Brown wire provides power for the 4-20 mA mode. If power is present on the Brown wire and not on the Red wire, the device enters the 4-20 mA mode automatically and stays in the 4-20 mode until power is removed from the Brown wire or is applied to the Red wire. The Red wire has priority — if power is applied to both wires at the same time, the device will operate in Modbus or SDI-12 modes but not in 4-20.

COMMUNICATIONS
The device automatically switches between Modbus and SDI-12 modes depending on which of the two interfaces has activity. Modbus and SDI-12 cannot be used at the same time — whichever one is currently in use will block communication on the other.

USING WIN-SITU
Win-Situ provides options for configuring analog/SDI-12 communications (Setup tab) and Modbus communications (File menu > Settings). In addition, the Level TROLL is capable of internal logging (programmed in Win-Situ) while participating in a Modbus, SDI-12 or analog network. However, Win-Situ cannot communicate with the Level TROLL while it is transmitting Modbus, SDI-12 or analog data, and conversely, the instrument cannot receive or respond to Modbus, SDI-12 or analog commands while connected to a PC serial port.

This “redundant logging” feature means

• if the PLC or recorder somehow “loses” data, the Level TROLL data can be retrieved using Win-Situ.
• if the PLC or recorder ceases to function due to power loss, the Level TROLL will continue to collect data using its own internal batteries and clock.

A port-powered RS485 converter like that shown for Modbus connections may be used for temporary connection of the Level TROLL to a serial port on a PC.

**FOR MORE INFORMATION**

For additional information on Modbus and SDI-12 communications, including the SDI-12 commands and Modbus registers, see these In-Situ technical notes:


They are available on the In-Situ software/resource CD, and in the Downloads section of the In-Situ website at www.In-Situ.com.
9 CARE & MAINTENANCE

OPERATING CONSIDERATIONS

The Level TROLL has been designed to withstand harsh field conditions. However, as with any electronic instrument, it can be permanently damaged if used outside its operating specifications.

TEMPERATURE

The Level TROLL 500 and Level TROLL 700 operate within a temperature range of -20°C to +80°C (-4°F to 176°F). The Level TROLL 300’s temperature range is 0°C to 50°C (32°F to 122°F).

PRESSURE RANGE

The Level TROLL can withstand pressures of up to two times (2X) the rated range of the pressure sensor without damage, although it may not read correctly at such pressure. If the pressure range is exceeded by 3X, the sensor will be destroyed.

CALIBRATION

Accuracy can be adversely affected by improper care and handling, lightning strikes and similar surges, exceeding operating temperature and pressure limits, physical damage or abuse. Factory calibration every 12-18 months is recommended. Contact In-Situ Customer Service for information on the factory maintenance and calibration plan.
SECTION 9: CARE & MAINTENANCE

STORAGE

Store the Level TROLL clean and dry. Place the protective red dustcap on the cable end, or store with cable attached to protect the connector pins and o-ring.

Store the instrument where it will be safe from mechanical shocks that may occur, such as rolling off a bench onto a hard surface.

Protect the instrument from temperature extremes. Store within a temperature range of -40°C to +80°C (-40°F to +176°F).

GENERAL MAINTENANCE

CLEANING—BODY AND FRONT END

Clean the Level TROLL body with water and a soft brush or plastic scouring pad, or soak overnight in a mild acidic solution, such as household vinegar.

If the ports in the front end are clogged with silt or mud, try the following:

- Swish the instrument vigorously in a bucket of clean water
- Apply a gentle squeeze of water from a wash bottle
- In severe cases, remove the nose cone and clean out the holes with a soft brush or pipe cleaner

To avoid damage to the pressure sensor diaphragm, do not insert any object into the sensor opening or attempt to dig out dirt or other materials.

If contamination cannot be removed using the recommendations above, please contact In-Situ Inc. for cleaning.
TWIST-LOCK CONNECTORS

Keep the pins on all connectors free of dirt and moisture by using the soft protective dustcap when cable is not attached.

CABLE VENT TUBE (VENTED CABLE)

Vented cable assures that atmospheric pressure is the reference pressure to the vented pressure sensor diaphragm. The vent tube should not be blocked, kinked, or otherwise obstructed. Such obstructions will cause barometric pressure to appear in measurements, and errors will be introduced due to thermal expansion and contraction of air within the vent tube and probe body.

The recommended minimum bend radius is 13.5 mm (0.54 in), which is twice the cable diameter.

BATTERIES

Internal batteries in the Level TROLL are not user-replaceable. The approximate percentage remaining is displayed on the Dashboard when the Level TROLL is connected in software.

TIP: If batteries are completely exhausted, remember that external power and battery pack options are available.

TIP: Be sure to replace the desiccant when it appears pink. Expired desiccant can allow water build up in the vent tube, causing a blockage resulting in inaccurate data.
TROUBLESHOOTING CONNECTIONS

Problem: Win-Situ cannot connect to the Level TROLL

Probable Cause: Wrong COM port selected, incompatible Communication settings, loose or dirty cable connections, low batteries

Suggested Remedy: Check the following:

- all cable connections are tight, connectors are clean and dry
- the cable is securely attached to the instrument
- the correct COM port is selected (select Preferences menu > Comm Settings to check this)
- the communication settings in Win-Situ and in the Level TROLL match. To reset the device communication settings to the serial defaults, click “Reset all Devices” in the Comm Settings dialog (Preferences menu > Comm Settings)
- the internal battery has voltage remaining, or external power is supplied
**Problem:** Real-time readings are in the wrong units

**Probable Cause:** Default units are being used

**Suggested Remedy:** Click the Sensors tab, select the sensor, click the configure button and select the desired units for each parameter in the Sensor Setup window. Click OK.

### TROUBLESHOOTING DATA LOGS

**Problem:** Cannot add a new log

**Probable Cause 1:** Only one “active” log can reside in the device at a time—an “active” log is a log that is Ready, Pending, Running, or Suspended as shown in the Status column of the Logging Tab

**Suggested Remedy:** Stop or delete the log if possible. Alternatively, configure the new log after the active log is completed

**Probable Cause 2:** The device has its maximum number of logs already stored—the Level TROLL 300, 500, and Baro TROLL have a capacity of 2 logs

**Suggested Remedy:** Download, and then delete a log you are through with. This will make room for an additional log on the device

**Problem:** New log exceeds available memory (message from software)

**Probable Cause:** The log as configured would exceed the device memory

**Suggested Remedy:** Edit the log and try these:

- Select a longer sampling interval
- If available, select the “Wrap data” option (later data will overwrite earlier data when the memory is full)
• For a log with a scheduled start, select “None” as the stop condition, or select a stop time that is closer to the start time. You may intend to stop the log before the scheduled end date arrives, but the software doesn’t know that.

TROUBLESHOOTING PARAMETER CONFIGURATION

Problem: Cannot configure level or other parameters using the Configure button on the Sensors tab. The Sensor setup screen is shown, but the Configure... button is dimmed out

Probable Cause 1: The Level TROLL is actively “polling” (continually updating real-time readings) in the Home tab

Suggested Remedy: Return to the Home tab and stop real-time readings by clicking

Probable Cause 2: The Level TROLL has an “active” log—a log that is Ready, Pending, Running, or Suspended as shown in the Status column of the Logging Tab. Only one “active” log can reside in the device at a time

Suggested Remedy: Stop or delete the log if possible. Alternatively, configure parameters after the log is completed
Index

A
AC adapter, 19
Accessories, 20
Active log, 73
ActiveSync, 21
Analog (4-20 mA)
  power, 66
  wiring, 62

B
Barometric pressure compensation, 51–52, 57
BaroTROLL, 57
Batteries, external, 19
Batteries, internal, 19, 70

C
Cable, 14–17
  attaching, 26–28
  bend radius, 55, 70
  communication cables, 18
  Kellem's grip, 54
  non-vented cable, 56
  programming cable, 18
  stripped & tinned, 16, 59, 60
  TROLL Com, 18, 29, 30, 43
  vented cable, 45, 55, 70
  wire, 14, 16, 56, 57
Calibration, 49–50
  factory, 49
  field, 49–50
Cleaning, 69
  decontamination, 12
Clock, setting, 36

D
Data. *See also* Logging data
  graphing, 42
  logging, 41–42
  viewing, 42
Decimal places displayed in Home screen, 35
Declaration of Conformity, 76
Depth, measuring, 45
Desiccant, 17, 43, 55, 70
  outboard, 61
  removing, 29

F
Factory recalibration, 49

H
Hanger, twist-lock, 20, 56, 57
Home tab (Win-Situ), 34

I
Installation, 53–55
  accessories for, 20
  non-vented, 56
  software, 31

L
Level, measuring, 45
Level sensor. *See* Pressure sensor
Level TROLL 300, 41, 51–52, 56
Log, active, 73
Logging data
  downloading, 42
  redundant logging, 66–67
  setting up, 41
  starting to log, 42
Logging tab (Win-Situ), 41

M
Maintenance, 69–70
Maintenance & calibration service, 10, 49
Microsoft ActiveSync, 21
Modbus
communication, 66
power, 66
wiring, 64, 65

N
Non-vented Level TROLL, 41, 56
data correction, 51–52
Nose cone, 69

P
Poll rate, changing, 35
Pressure, measuring, 45
Pressure range, 68
usable depth, 23, 53
Pressure sensor
absolute vs. gauged, 44–45
calibration, 49
do not touch!, 69
non-vented vs. vented, 44–45
zeroing, 49
Product specifications, 22–23
Profiling, 34
Programming cable, 18
attaching to Level TROLL, 26–28
PSIA, 44
PSIG, 45

R
Real-time readings, 34
units, 35
Repair service, 10
Reset communications, 71
RMA, 11

S
SDI-12
communication, 66
power, 66
wiring, 63
Sensors tab (Win-Situ), 46, 50
Serial number, 8
Site, 37–40
Software. See Win-Situ
Software upgrades, 10
Specifications, 22–23
Storage, 69

T
Temperature range, 68
Tests. See Logging data
Thermal stabilization, 55
TROLL Com, 18
attaching to cable, 29
attaching to computer, 30
removing, 43
Troubleshooting, 71–73

U
Units, 35, 72

V
Vented cable, 45
bend radius, 55, 70

W
Warranties, 10
Win-Situ, 21
BaroMerge, 51–52
connecting to Level TROLL, 32–34
Control Panel, 34
Dashboard, 34
exiting, 43
installing, 31
redundant logging, 66–67
site, 37–40
Software Manager, 31
system requirements, 21
tabs, 34
Win-Situ Mobile, 21, 31
Wiring
4-20 mA, 62
Modbus RS232, 65
Modbus RS485, 64
SDI-12, 63
Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Level TROLL
Model: Level TROLL 300
Product Description: The Level TROLL measures and logs level and temperature in natural groundwater and surface water.

is in compliance with the following Directives:


and meets or exceeds the following international requirements and compliance standards:

- **Immunity**
  EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

- **Emissions**
  Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE mark is affixed accordingly.

Todd Campbell
New Product Development Program Manager
In-Situ, Inc.
January 17, 2006
Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Level TROLL
Model: Level TROLL 500
Product Description: The Level TROLL measures and logs level and temperature in natural groundwater and surface water.

is in compliance with the following Directives:


and meets or exceeds the following international requirements and compliance standards:

- **Immunity**
  EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

- **Emissions**
  Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE mark is affixed accordingly.

Todd Campbell
New Product Development Program Manager
In-Situ, Inc.
January 17, 2006
Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Level TROLL
Model: Level TROLL 700
Product Description: The Level TROLL measures and logs level and temperature in natural groundwater and surface water.

is in compliance with the following Directives:


and meets or exceeds the following international requirements and compliance standards:

- **Immunity**
  EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

- **Emissions**
  Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE mark is affixed accordingly.

Todd Campbell
New Product Development Program Manager
In-Situ, Inc.
January 17, 2006
Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:
Product name: Level TROLL
Product name: Baro TROLL
Product Description: The Baro TROLL measures and logs barometric pressure and temperature.

is in compliance with the following Directives:


and meets or exceeds the following international requirements and compliance standards:

- **Immunity**
  EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

- **Emissions**
  Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE mark is affixed accordingly.

Todd Campbell
New Product Development Program Manager
In-Situ, Inc.
January 17, 2006